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Lucrarea de laborator nr. 1  

CREAREA DESENULUI-PROTOTIP  

Scopul lucrării: Studiu general al modului de operare al 

programului AutoCAD 2008. Executarea desenului-prototip.  

Obiectivele lucrării:  Studierea modului de lansare a aplicaţiei 

AutoCAD. Cunoaşterea interfeţei, a modului de lansare a comenzilor 

şi de introducere a datelor. Familiarizarea cu diverse sisteme de 

coordonate, moduri de desenare, inscripţionare şi vizualizare. 

Stabilirea mediului de desenare.   

Etapele de executare a lucrării:  

1. Stabilirea limitelor desenului  

2. Stabilirea reţelelor GRID şi SNAP  

3. Afişarea întregului desen  

4. Crearea straturilor   

5. Stabilirea stilului de text  

6. Stabilirea stilului de cotare  

7. Construirea chenarului  

8. Construirea indicatorului  

9. Completarea indicatorului  

10. Salvarea desenului  

1.   Stabilirea limitelor desenului  

Format → Drawing Limits   

 

Command: '_limits  

Reset Model space limits:  

Specify lower left corner or [ON/OFF] <0.0000,0.0000>: 0,0    

Specify upper right corner <420.0000,297.0000>: 210,297     
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2.   Stabilirea reţelelor GRID şi SNAP  

Tools → Drafting Settings  sau   
clic-dreapta SNAP → Settings   

 

Se indică valoarea numerică a pasului reţelelor. 

3.   Afişarea întregului desen  

View → Zoom → All  

 

http://shuletea.ucoz.net/index/003/0-9
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4. Crearea straturilor  

Format → Layer    

 

Se crează straturile necesare cărora li se acordă proprietăţile 

(culoarea, grosimea, tipul liniei etc.) solicitate.  

Se recomandă crearea următoarelor straturi:  

  

 

Name Color Linetype Lineweight 

0 

Contur 

Subţire 

Cote 

Haşură 

Axe 

Invizibil 

Text2.5 

Text3.5 

Text5 

Text7 

White 

Culoare 

Culoare 

Culoare 

Culoare 

Culoare 

Culoare 

White 

White 

White 

White 

Continuous 

Continuous 

Continuous 

Continuous 

Continuous 

ACAD_ISO04W100 

ACAD_ISO02W100 

Continuous 

Continuous 

Continuous 

Continuous 

  Default 

0.60 

0.20 

0.20 

0.30 

0.20 

0.30 

0.25 

0.35 

0.50 

0.70 
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5.   Stabilirea stilului de text  

Format → Text Style  

 

 6.   Stabilirea stilului de cotare  

Format → Dimension Style  

 

Se creează un stil nou (New) sau se modifică cel existent. 

Se modifică parametrii ce determină: 

Se recomandă următorii 

parametri: 

 Style name  Standard 

 Font name  isocp.shx 

 Height  0 

 Width factor  1 

 Oblique angle 15 

http://shuletea.ucoz.net/index/003/0-9
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  Tipul și dimensiunile liniilor şi săgeţilor (Lines and Arrows) 

 
 

 Aspectul, înalțimea şi poziția textului (Text) 
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 Opţiuni referitoare la amplasarea elementelor cotării (Fit) 

 
 

 Factorul de scalare şi precizia cotelor afişate (Primary Units)  
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7. Construirea chenarului  

Se recomandă utilizarea comenzii Rectangle. 

 

 Construirea cadrului colii de desen 

Layer : Subtire  

Command: rectang    

Specify first corner point or 

[Chamfer/Elevation/Fillet/Thickness/Width]: 0,0    

Specify other corner point or [Dimensions]: 210,297   

 Construirea chenarului şi conturului indicatorului 

Layer : Contur  

Command: rectang   

Specify first corner point or 

[Chamfer/Elevation/Fillet/Thickness/Width]: 20,5    

Specify other corner point or [Dimensions]: 205,292   

Command: rectang   

Specify first corner point or 

[Chamfer/Elevation/Fillet/Thickness/Width]: 20,5   

Specify other corner point or [Dimensions]: 205,60   

http://shuletea.ucoz.net/index/7_5_rectangle/0-21
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8.   Construirea indicatorului  

      Command:  <Ortho on>  

Pentru construire se va utiliza comanda Line din meniul Draw 

(introducerea  directă a lungimii).  

Command: line    

Specify first point: 20 ,60   

Specify next point or [Undo]: se deplasează cursorul în dreapta cu 

mouse-ul și se tastează 7    

Specify next point or [Undo]: se indică direcţia în jos și se tastează 25    

etc.  

După desenarea unei linii subțiri orizontale a indicatorului 

pentru multiplicarea acesteia poate fi utilizată comanda Copy din 

meniul Modify. 

Command: copy    

Select objects: S1 (se selectează linia orizontală) 

Select objects:    (se încheie selecția) 

Specify base point:  P1 (se indică un punct pe linia selectată) 

Specify second point:  P2 (se indică un punct la distanța de 5 mm) 

Specify second point:  P3 (se indică un punct la distanța de 10 mm) 

etc. 

 

  

http://shuletea.ucoz.net/index/071/0-17
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9.  Completarea indicatorului  

Pentru a facilita procesul de inscripţionare se va activa modul 

ORTHO şi se va stabili pasul  Snap  egal cu 1. 

 

Pentru inscripţionare se va utiliza comanda Single line text  cu 

opţiunea implicită Left (start point). Pentru încadrarea inscripțiilor se vor 

aplica opţiunile Justify, apoi -  Fit. 

Command: _dtext  

Current text style:  "Standard"  Text height:  2.5000  

Specify start point of text or [Justify/Style]:  j    

Enter an option [Align/Fit/Center/Middle/Right/ 

TL/TC/TR/ML/MC/MR/BL/BC/BR]: f    

Specify first endpoint of text baseline: (se indică I punct)  

Specify second endpoint of text baseline: (se indică punctul II )  

Specify height <2.5000>:     

Enter text: Mod.    

Enter text:   

  10.   Salvarea desenului  

File  →Save as  

Desenul-prototip (fig. 1) se va salva ca fişier .dwg (în versiunea 

AutoCAD necesară)  în mapa  creată pentru păstrarea desenelor, se 

va imprima și se va prezenta la control.  

Denumirea fişierului se recomandă a fi:  Nume de familie_1  

http://shuletea.ucoz.net/index/7_11_single_line_text/0-27
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 Fig. 1. Desen-prototip formatul A4 
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Lucrarea de laborator nr. 2  

GARNITURĂ  

Scopul lucrării: Familiarizarea cu comenzile de desenare, 

modificare, inscripţionare şi cotare ale programului AutoCAD.  

Obiectivele lucrării:  Studierea modalităţii utilizării 

comenzilor de desenare a entităţilor de bază. Studierea metodelor de 

selectare a obiectelor şi a comenzilor de modificare a desenelor. 

Familiarizarea cu comenzile de cotare a desenelor. Executarea 

proiecţiei şi cotarea unei piese de tip „Garnitură”.  

Etapele de executare a lucrării:  

1.   Deschiderea desenului prototip şi salvarea cu alt nume  

2.   Construirea axelor  

3.   Construirea cercurilor ajutătoare  

4.   Construirea conturului piesei  

5.   Ajustarea axelor  

6.   Cotarea desenului  

7.   Redactarea cotelor  

8.   Salvarea desenului  

 

1. Deschiderea desenului prototip şi salvarea cu alt nume  

Se ve deschide desenul prototip format A4 creat în lucrarea de 

laborator nr.1 (Desen prototip).  După introducerea schimbărilor în 

indicator (codul, denumirea desenului), fişierul se va salva cu 

denumirea   Nume de familie_2  

2. Construirea axelor  

Axele se vor construi cu comanda Line în stratul „Axe”, 

modurile de desenare ORTHO şi OSNAP fiind activate.   

Layer : Axe  

Command:  <Ortho on> <Osnap on>  

Se va utiliza comanda Line   (punctarea cu mouse-ul)   
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Command: _line   

Specify first point:  se indică  punctul P1   

Specify next point or [Undo]: se indică  punctul P2   

Specify next point or [Undo]:     

Command: _line     

Specify first point:  se indică  punctul P3  

Specify next point or [Undo]: se indică  punctul P4  

Specify next point or [Undo]:     

Pentru copierea axelor la o distanţă stabilită se vor utiliza 

comenzile Copy sau Offset  

Command: _offset     

Current settings: Erase source=No  Layer=Source 

 OFFSETGAPTYPE=0  

Specify offset distance or [Through/Erase/Layer] <Through>: 35    

Select object to offset or [Exit/Undo] <Exit>: se indică axa verticală 

( punctul P5 )  

Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: se 

indică direcţia (punctul P6 )  
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Select object to offset or [Exit/Undo] <Exit>: se indică axa verticală 

( punctul P5 )  

Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: se 

indică direcţia (punctul P7 )  

Select object to offset or [Exit/Undo] <Exit>:     

 

3. Construirea cercurilor ajutătoare  

În caz de necesitate se va activa stratul „Subţire” şi se vor 

construi cu comanda Circle cercurile circumscrise poligoanelor. 

Centrele cercurilor vor fi plasate cu exactitate (asigurată de OSNAP - 

intersection “  „) la intersecţia axelor. Raza cercurilor se introduce 

de la tastatură.  

4. Construirea conturului piesei  

În stratul „Contur” se va construi conturul piesei utilizând 

comenzile Circle, Polyghon, Ellipse, Rectangle.  

4.1. Construirea poligonului            

Se va realiza urmând indicaţiile din zona de 

comandă: se introduce numărul de laturi, centrul 

poligonului se arată cu mouse-ul (precizia este 

asigurată de OSNAP - intersection  “  „), se 

optează pentru poligon înscris (Inscribed) în cerc, 

raza cercului poate fi indicată cu mouse-ul (la 

intersecţia cercului cu axa)  

 

Command: _polygon   

Enter number of sides <4>: 6     

Specify center of polygon or [Edge]: se indică punctul de intersecţie 

al axelor (punctul P8 )  

Enter an option [Inscribed in circle/Circumscribed about circle] 

<I>:     

Specify radius of circle: se indică punctul de intersecţie al cercului 

cu axa verticală ( punctul P9 )  
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4.2. Construirea elipsei       

Se va executa alegând opţiunea Center pentru a 

plasa exact elipsa la intersecţia axelor. Dimensiunile 

elipsei se indică utilizând metoda introducerii directe 

a lungimii cu indicarea direcţiei.  

Command: _ellipse 

Specify axis endpoint of ellipse or [Arc/Center]: C    

Specify center of ellipse:  se indică punctul de 

intersecţie al axelor (punctul P10 )  

Specify endpoint of axis: se indică direcţia spre capătul axei verticale 

(punctul P11 )  și se tastează 25    

Specify distance to other axis or [Rotation]: 15    

 

Notă: În variantele în care 

conturul exterior al garniturii este 

un dreptunghi, construcţiile se 

vor începe de la dreptunghi  , 

axele plasându-se la mijlocurile 

“ Δ „  laturilor.  

  

Layer : Contur  
Command: _rectang  

Specify first corner point or 

[Chamfer/Elevation/Fillet/Thickn

ess/Width]: se indică punctul P12)  

Specify other corner point or 

[Area/Dimensions/Rotation]: 

@100,150     

 

 

Layer : Axe  

Command:  <Ortho on>  

Command: _line Specify first point:  <Osnap on> _mid of se indică 

punctul P13  
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Specify next point or [Undo]: se indică punctul P14  

Specify next point or [Undo]:      

Command: _line Specify first point: _mid of  se indică punctul P15  

Specify next point or [Undo]:  se indică punctul P16  

Specify next point or [Undo]:     

 

5. Ajustarea axelor  

Pentru scurtarea sau alungirea axelor se va utiliza comanda 

Lengthen  (opţiunea Dynamic) sau punctele de prindere ale 

segmentului de dreaptă, iar pentru modificarea scării liniei – 

comanda Ltscale sau Linetype scale din caseta Properties. Axele 

trebuie să depăşească conturul cu 1-5 mm și nu trebuie să se 

intersecteze pe interval sau punct. 

  

6. Cotarea desenului  

Cotarea se va efectua în stratul „Cote” utilizând instrumentele 

din bara de instrumente sau meniul Dimension  
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7. Redactarea cotelor  

Înclinarea liniei ajutătoare a cotei se execută cu opțiunea 

Oblique din meniul Dimension. 

Adăugarea simbolului diametrului Ø poate fi realizată pe calea:  

      Modify → Object → Text → Edit  

8. Salvarea desenului:   File  → Save  

Exemplu de executare a lucrării grafice vezi în fig. 2.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 2. Lucrarea grafică «Garnitură» 
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Lucrarea de laborator nr. 3 

RACORDĂRI 

Scopul lucrării: Familiarizarea cu metodele de utilizare a 

opţiunilor comenzilor AutoCAD în vederea executării diverselor 

construcţii geometrice.  

Obiectivele lucrării:  Studierea diverselor opţiuni ale 

comenzilor AutoCAD pentru desenarea precisă. Studierea metodelor 

de construire a segmentelor de lungime dată, segmentelor înclinate 

sub un unghi determinat, de construire a dreptelor tangente la două 

cercuri, reciproc perpendiculare sau paralele. Modalitatea de 

racordare interioară, exterioară şi mixtă. Retezarea entităţilor. 

Executarea proiecţiei şi cotarea unei piese de tip „Racordări”.  

Etapele de executare a lucrării:  

1. Deschiderea desenului prototip şi salvarea cu alt nume  

2. Construirea axelor  

3. Construirea conturului de bază al piesei  

4. Executarea racordărilor şi a liniilor tangente  

5. Ajustarea axelor  

6. Cotarea desenului  

7. Salvarea desenului  

1. Deschiderea desenului prototip şi salvarea cu alt nume  

Se ve deschide desenul prototip format A4 creat în lucrarea de 

laborator nr. 1 (Desen prototip)   

După introducerea schimbărilor în indicator (codul, denumirea 

desenului) fişierul se va salva cu denumirea   Nume de familie_3.  

2. Construirea axelor  

Axele se vor construi cu comanda Line în stratul „Axe”, 

modurile de desenare ORTHO şi OSNAP fiind activate. Pentru 

copierea axelor la o distanţă stabilită se vor utiliza comenzile Copy 

sau Offset. (Vezi Lucrarea de laborator nr. 2).  

În cazul în care e necesară construirea liniilor înclinate, se vor 

utiliza coordonate polare, sau se va activa modul POLAR de lucru.  
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Înainte de utilizarea modului POLAR de lucru se va seta 

unghiul dorit (sau valoarea egală cu divizorul):  

Tools → Drafting Settings → Polar Tracking  

 

Se activează POLAR şi OSNAP:  

    Command:  <Polar on>  

    Command:  <Osnap on>  

Când se va desena dreapta, la 

fiecare 15° va apărea o linie 

întreruptă care va fixa direcţia.   

Ex. de desenare a unui segment de 

dreaptă:  

      Command: _line  

    Specify first point: se indică capătul segmentului (P1)  

       Specify next point or [Undo]:  se indică punctul P2  

       Specify next point or [Undo]:   
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3. Construirea conturului de bază al piesei  

În stratul „Contur” se va construi conturul de bază al piesei cu 

comenzile Line (utilizând coordonate relative sau introducerea 

directă a distanţei), Circle  etc.   

Se consideră de bază cercurile, centrele cărora sunt determinate 

prin cote.  

4. Executarea  racordărilor şi a liniilor tangente  

Tangentele comune se execută cu comanda Line utilizând 

opţiunea Tangent al modului OSNAP.   

Command: _line  

Specify first point: tan    

   to  (se indică punctul P1) 

Specify next point or 

[Undo]: tan   

   to  (se indică punctul P2)  

Specify next point or [Undo]:  

 

Racordările exterioare se execută cu comanda Fillet    

 
Command: _fillet  

Current settings: Mode = TRIM, Radius = 10.0000  

Select first object or [Undo/Polyline/Radius/Trim/Multiple]:  R   

Specify fillet radius <10.0000>: 50   

Select first object or [Undo/Polyline/Radius/Trim/Multiple]: se  

indică punctul P1  

Select second object or shift-select to apply corner:  se indică 

punctul P2 . 
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Racordările interioare şi mixte se execută cu opţiunea TTR a 

comenzii Circle   

 

Command: _circle  

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: TTR   

Specify point on object for first tangent of circle:  se indică 

punctul P1  

Specify point on object for second tangent of circle:  se indică 

punctul P2  

Specify radius of circle <50.0000>: 100  

 

Utilizarea comenzii Circle cu opţiunea TTR   pentru racordare 

necesită retezarea cercului, executată cu comanda  Trim    

Command: _trim  

Current settings: 

Projection=UCS,        

 Edge=None  

Select cutting edges ... se indică 

punctele P1 şi P2 , apoi   

Select object to trim or shift-

select to extend or  

[Fence/Crossing/Project/Edge/eRase/Undo]:  se indică punctul P3  

Select object to trim or shift-select to extend or  

[Fence/Crossing/Project/Edge/eRase/Undo]:   

5. Ajustarea axelor  

Pentru scurtarea sau alungirea axelor se vor utiliza punctele 

de prindere sau comanda Lengthen, iar pentru modificarea scării 

liniei axiale - Linetype scale din caseta Properties.  
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6. Cotarea desenului  

Cotarea se va efectua în stratul „Cote” utilizând 

instrumentele din bara de instrumente sau meniul Dimension.  

7. Salvarea desenului:  File  → Save   

Exemplu de executare a lucrării grafice vezi în fig. 3.  

 
 Fig. 3. Lucrarea grafică «Racordări» 
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Lucrarea de laborator nr. 4  

CREAREA PROECŢIILOR IZOMETRICE  

Scopul lucrării: Familiarizarea cu modul de reprezentare a 

obiectelor în proiecţie axonometrică izometrică.  

Obiectivele lucrării: Studierea facilităţilor oferite de 

AutoCAD la realizarea proiecţiilor izometrice. Studierea comenzilor 

şi opţiunilor specifice reprezentării, cotării, precum şi haşurării 

suprafeţelor secţionate ale proiecţiilor izometrice. Executarea 

proiecției izometrice a unei piese.  

Etapele de executare a lucrării:  

1. Deschiderea desenului prototip şi salvarea cu alt nume  

2. Stabilirea reţelelor GRID şi SNAP izometrice  

3. Activarea modului ORTHO de desenare  

4. Schimbarea formei cursorului  

5. Desenarea conturului piesei  

6. Executarea secţiunii  

7. Cotarea  

8. Salvarea desenului  

 

1.  Deschiderea desenului prototip şi salvarea cu alt nume   

Desenul se va salva cu denumirea Nume de familie_4  

2.  Stabilirea reţelelor GRID şi SNAP izometrice  

SNAP (clic-dreapta) → Settings → Isometric snap  

 

http://shuletea.ucoz.net/index/003/0-
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Command:  <Snap on>  

Command:  <Grid on>  

3. Activarea modului ORTHO de desenare  

Ortho →  On  

Command:  <Ortho on>  

4. Schimbarea formei cursorului  

  tasta   F5  

 combinaţia   Ctrl+E   

 din linia de comandă : ISOPLANE   

 

Command:  <Isoplane Right>  

Command:  <Isoplane Left>  

Command:  <Isoplane Top>  

5. Desenarea axelor şi a conturului piesei    

În stratul "Axe" cu comanda Line se vor desena axele găurilor 

care sunt suprafeţe de rotaţie.  

Conturul vizibil va fi construit în stratul  "Contur". Se vor 

utiliza comenzile Line (introducerea  directă a lungimii),  Ellipse 

 (opţiunea Isocircle).  

 Desenarea liniilor (se utilizează metoda introducerii directe a 

distanţei): 

Command:  <Ortho on>  

Command: _line Specify first point: (se indică primul punct)  

Specify next point or [Undo]: (se indică direcţia) 60   

 Desenarea cercurilor izometrice: 

Command: _ellipse  

Specify axis endpoint of ellipse or [Arc/Center/Isocircle]: i   

Specify center of isocircle: (se indică centrul)  

Specify radius of isocircle or [Diameter]: 20  

http://shuletea.ucoz.net/index/003/0-
http://shuletea.ucoz.net/index/071/0-17
http://shuletea.ucoz.net/index/071/0-17
http://shuletea.ucoz.net/index/079/0-25
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6. Executarea secţiunii  

Se va înlătura o parte din piesa pentru a reprezenta cavităţile.  

 Haşurarea  

Se va haşura locul secţionat prin intermediul comenzii  Hatch: 
 

 
 

Unghiul (Angle) va fi următorul:  

-       în planul XOZ –   15
o
;  

-       în planul YOZ –   75
o
;  

-       în planul XOY – 135
o
.  

 

http://shuletea.ucoz.net/index/0710/0-26
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7. Cotarea  

Se va cota  în stratul "Cote", modul OSNAP fiind activat, cu 

comanda Aligned dimension: 

Command:  <Osnap on> 

  
 

Cotele se vor redacta (li se va oferi direcţia corectă) cu 

comanda Oblique: 
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Redactarea cotei poate fi necesară și pentru adăugarea 

simbolului diametrului: 

  

 



 
29 

8. Salvarea desenului: File  → Save   

Exemplu de executare a lucrării grafice vezi în fig. 4.  

 
 Fig. 4. Lucrarea grafică «Izometrie» 
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Lucrarea de laborator nr. 5 

MODEL SOLID PLAN 

Scopul lucrării: Familiarizarea cu modul de lucru în vederea 

creării modelelor solide de tipul «Garnitură».  

Obiectivele lucrării: Familiarizarea cu instrumentele de lucru 

în spaţiul tridimensional. Studierea metodelor dinamice de creare a 

obiectelor tridimensionale, de redactare prin intermediul operaţiilor 

booleene. Studierea metodelor de vizualizare şi nuanţare a 

modelelor.  

Etapele de executare a lucrării:  

1. Deschiderea desenului din lucrarea “Racordări” şi salvarea  

cu un alt nume  

2. Afişarea barelor de instrumente necesare pentru lucru           

în spaţiul 3D  

3. Eliminarea cotelor si a axelor  

4. Crearea regiunilor din conturul garniturii  

5. Scăderea găurilor   

6. Nuanţarea modelului  

7. Conferirea grosimii regiunii create  

8. Vizualizarea modelului  

9. Perfectarea lucrării  

10. Salvarea desenului  

1. Deschiderea desenului din lucrarea “Racordari” şi salvarea lui 

cu un alt nume  

Se va deschide lucrarea “Racordari”. După introducerea 

schimbărilor în indicator (codul, denumirea desenului) fişierul se va 

salva cu denumirea   Nume de familie_5.  

2. Afişarea barelor de instrumente necesare pentru lucru în 

spaţiul 3D  

Făcând clic-dreapta pe pictograma oricărei comenzi afişăm lista 

barelor din care vom activa suplimentar barele de instrumente:  

Orbit (pentru versiunile mai vechi ale AutoCAD – 3D ordit)  

file:///C:/Documents%20and%20Settings/gdd/My%20Documents/Downloads/Racordari%23Deschiderea_desenului_din_lucrarea_
file:///C:/Documents%20and%20Settings/gdd/My%20Documents/Downloads/Racordari%23Deschiderea_desenului_din_lucrarea_
file:///C:/Documents%20and%20Settings/gdd/My%20Documents/Downloads/găurilor%23Scăderea_
http://docs.google.com/Doc?docid=0AcnTaFbUnUIRZGR6dDV2ZDlfMTI0ZzM2NWJzZjU&amp;hl=en#10._Cotarea_desenului
http://docs.google.com/Doc?docid=0AcnTaFbUnUIRZGR6dDV2ZDlfMTI0ZzM2NWJzZjU&amp;hl=en#10._Cotarea_desenului
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Modeling (pentru versiunile mai vechi ale AutoCAD – Solid)  

Solid Editing  

UCS  

View  

Visual Styles  (pentru versiunile mai vechi ale AutoCAD – Shade)  

   

 
 

3. Eliminarea cotelor si a axelor  

Pentru a crea modelul se vor înlătura toate liniile şi inscripţiile 

de pe câmpul garniturii. Acest lucru poate fi realizat prin îngheţarea 

sau stingerea stratului “Axe” şi “Cote”.  
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4. Crearea regiunilor din conturul garniturii 

Se va alege un strat de o culoare mai deschisă, ce se va deosebi 

de culoatea conturului, dar care  va fi diferit de straturile “Cote” sau 

“Axe” eliminate anterior.  

Pentru a transforma conturul garniturii în regiuni se va utiliza 

comanda Region               din bara de instrumente Draw: 

Command: _region  

Select objects: (se deschide fereastra ce va cuprinde conturul figurii 

din desen) P1 

Specify opposite corner: (se va specifica colțul opus al ferestrei) P2  

Select objects:   

2 loops extracted. 

2 Regions created.  

În cazurile în care conturul nu este perfect închis sau conţine 

linii care se intersectează (au fost comise greşeli la racordare), 

regiunea nu va fi creată şi culoarea conturului respectiv nu se va 

schimba.  

5. Scăderea găurilor  

Cu comanda Subtract   din bara de instrumente Solid 

Editing  se vor elimina regiunile ce constituie găuri.  

Command: _subtract  

Select solids and regions to subtract from .. (se selectează regiunea 

exterioară din care se vor “scădea” găurile)  

Select objects: 1 found   

Select objects:  

Select solids and regions to subtract .. (se selectează regiunile – 

găurile, ce urmează a fi “scăzute”)  

Select objects: 1 found  

Select objects:  
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6. Nuanţarea modelului  

Pentru vizualizarea rezultatului se nuanțează regiunea 

aplicând opțiunile Realistic Visual Style şi Conceptual Visual 

Style  din bara de instrumente Visual Styles: 

  

 

 

 

 

 

 

7. Conferirea grosimii regiunii create  

Conferirea grosimii regiunii create se va realiza cu comanda 

Extrude   din bara de instrumente Modeling: 

Command: _extrude  

Current wire frame density:  ISOLINES=4  

Select objects to extrude: (se selectează regiunea)  

1 found  

Select objects to extrude:  

Specify height of extrusion or [Direction/Path/Taper angle]: (se 

indică valoarea înălţimii – grosimii garniturii)  

*A nu se confunda comanda Extrude cu butonul ce are acelaşi 

aspect al comenzii Extrude face din bara Solid Editing.  

8. Vizualizarea modelului  

Pentru a putea fi examinat în spaţiu modelul poate fi rotit cu 

una din comenzile barei Orbit  . 
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9. Perfectarea lucrării  

Pentru a-i conferi lucrării un aspect finisat se va alege  

imaginea pentru plasarea în format. Pentru aceasta:  

 se va afişa vederea de sus, utilizând butonul Top                   

al barei View;  

 se va copia chenarul şi indicatorul în memoria calculatorului 

cu comanda Cut             din  bara Standard de instrumente;  

 se va alege o poziţie a modelului cu unul din instrumentele 

barei Orbit, sau o poziţie prestabilită Isometric din  bara 

View;  

 cu opțiunea View       din bara de instrumente UCS se va 

instala un sistem de coordonate nou, planul xOy al căruia va 

fi paralel cu ecranul;  

 cu comanda Paste   din bara Standard de instrumente se 

va introduce indicatorul şi chenarul . 

10. Salvarea desenului  

File  → Save  

Exemplu de executare a lucrării grafice vezi în fig. 5.
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Fig. 5. Lucrarea grafică «Model plan» 
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Lucrarea de laborator nr. 6  

CREAREA UNUI MODEL SOLID 3D  

Scopul lucrării: Familiarizarea cu modul de creare a solidelor 

3D, combinând metoda dinamică cu metoda  utilizării  solidelor 

primitive. Utilizarea operaţiilor booleene pentru solide. 

Obiectivele lucrării: Familiarizarea cu diverse instrumente ale 

barei Modeling. Utilizarea sistemelor de coordonate ale utilizatorului 

(UCS). Studierea metodelor de creare a corpurilor tridimensionale 

din solide primitive şi de redactare cu instrumentele din bara Solid 

Editing.  

Etapele de executare a lucrării:  

1. Deschiderea unui desen nou şi salvarea lui  

2. Crearea modelului solid 3D 

 2.1. Generarea solidului prin revoluţie  

                   2.2. Utilizarea solidelor primitive  

3. Redactarea solidelor  

4. Salvarea desenului  

 

1.  Deschiderea unui desen nou şi salvarea lui  

Se va deschide un desen nou:   

File  → New  

Fişierul se va salva:    

File  → Save as → Nume de familie_6  

2.  Crearea modelului solid 3D 

În procesul de creare a modelului solid se va recurge la 

combinarea diferitelor metode de generare a solidelor şi de redactare 

a acestora.  

2.1  Generarea solidului prin revoluţie   

Se construieşte conturul plan al piesei cu ajutorul 

comenzii Line    din bara de instrumente Draw.  

http://docs.google.com/Doc?docid=0AcnTaFbUnUIRZGR6dDV2ZDlfMTI0ZzM2NWJzZjU&amp;hl=en#10._Cotarea_desenului
http://shuletea.ucoz.net/index/071/0-17
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Command: _line Specify first 

point: 25,0    (p.A)  

Specify next point or [Undo]: 

25,100    (p.B)  

Specify next point or [Undo]: 

40,100     (p.C)  

Specify next point or [Close/ 

Undo]: 40,40   (p.D)  

Specify next point or [Close/ 

Undo]: 60,40    p.E)  

Specify next point or [Close/ 

Undo]: 60,0      (p.F)  

Specify next point or [Close/ 

Undo]: C     (p.A)  

 

          Din conturul realizat se creează o regiune cu comanda Region  

 din bara de instrumente Draw.  

Command: _region 

Select objects: (se deschide fereastra ce cuprinde conturul creat)  

Specify opposite corner: (se specifică colțul opus al ferestrei) 6 found  

Select objects:   

1 loop extracted.  

1 Region created.  

  Cu comanda Revolve                 a barei de instrumente  

Modeling (Solid - pentru versiunile AutoCAD mai vechi) regiunea va 

fi rotită în jurul unei axe în vederea obținerii unui corp de rotaţie.  

Command: _revolve  

Current wire frame density:  ISOLINES=4  

Select objects to revolve: 1 found    (se selectează regiunea)  

Select objects to revolve:     

Specify axis start point or define axis by [Object/X/Y/Z] <Object>: 

0,0  

Specify axis endpoint: 0,10  

Specify angle of revolution or [STart angle] <360>:   
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2.2  Utilizarea solidelor primitive      

Cu comanda Box  a barei de instrumente Modeling se va 

construi paralelipipedul ce va constitui canalul prismatic al 

corpului.  
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Command: _box  

Specify first corner or [Center]: C   

Specify center: 0,0    

Specify corner or [Cube/Length]: 20,20    

Specify height or [2Point] <65.0000>: 140    

 

Cu comanda Origin  a  barei de instrumsnte UCS  se va 

schimba centrul sistemului de coordonate în vederea executării 

găurii cilindrice. Coordonatele noului centru al sistemului 

 fiind O (0,70,0)  

Command: ucs  

Current ucs name:  *NO NAME*  

Specify origin of UCS or [Face/NAmed/OBject/Previous/View/ 

World/X/Y/Z/ZAxis]  <World>: 0,70  

Specify point on X-axis or <Accept>:   

Gaura cilindrică va fi realizată cu comanda Cylinder 
   a barei de instrumente Modeling.  
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Command: _cylinder  

Specify center point of base or [3P/2P/Ttr/Elliptical]: 0,0    

Specify base radius or [Diameter] <34.0582>: 10    

Specify height or [2Point/Axis endpoint] <130.00>:  60   

 

3. Redactarea solidelor 

Cu comanda Subtract    a barei de instrumente Solid 

Editing  se vor executa găurile. 

 

 

Command: _subtract Select solids and regions to subtract from ..  

Select objects: (se selectează corpul de rotaţie) 1 found    

Select objects:    

Select solids and regions to subtract ..  

Select objects: (se selectează prisma) 1 found      

Select objects: (se selectează cilindrul) 1 found, 2 total  

Select objects:     
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4.  Salvarea desenului 

 Se alege o poziţie izometrică a modelului cu Isometric din  

bara View: 

 Cu comanda View       din bara de instrumente UCS se 

instalează un sistem de coordonate nou, planul xOy al căruia 

va fi paralel cu ecranul;  

 Se deschide un desen existent (de ex. Desen-prototip), se 

copie cu comanda Copy din  bara Standard de instrumente 

tot conținutul; 

 Se trece prin meniul Window la fișierul care conține modelul 

realizat; 

 Cu comanda Paste   din bara Standard de instrumente se 

inserează indicatorul şi chenarul; 

 După introducerea schimbărilor în indicator (codul, 

denumirea desenului) fişierul se salvează cu denumirea deja 

atribuită:  Nume de familie_6: 

File  → Save  

Exemplu de executare a lucrării grafice vezi în fig. 6.
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Fig. 6. Lucrarea grafică «Model solid 3D» 
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Lucrarea de laborator nr. 7  

DESENUL DE EXECUŢIE AL UNUI MODEL SOLID  

Scopul lucrării: Familiarizarea cu modul de creare a desenului 

de execuție al modelului solid. Studierea metodelor de generare a 

vederilor şi secţiunilor unui model solid.  

Obiectivele lucrării: Familiarizarea cu diverse instrumente ale 

barei Modeling. Utilizarea sistemelor de coordonate ale utilizatorului 

(UCS). Lucrul în spaţiul hârtie. Studierea metodelor de generare a 

vederilor şi secţiunilor unui model solid.  

Etapele de executare a lucrării:  

1. Comutarea la Spaţiul Hârtie  

2. Generarea vederilor  

3. Obţinerea secţiunii simple  

4. Realizarea desenului  

5. Salvarea desenului  

 1.  Comutarea la Spaţiul Hîrtie  

În vederea creării desenului de execuţie se va comuta în Paper 

Space (spaţiul hârtie). Pentru aceasta se va alege una din variantele:  

        - se va apăsa butonul  Layout1 sau  Layout2;  

        - se va apăsa butonul Model din bara de stare. 

În caseta Page Setup Manager, care poate afişată din meniul 

File sau din meniul de scurtătură Layout1 (clic-dreapta pe Layout1) 

se modifică formatul, alegându-se un format A3.  

 

http://docs.google.com/Doc?docid=0AcnTaFbUnUIRZGR6dDV2ZDlfMTI0ZzM2NWJzZjU&amp;hl=en#10._Cotarea_desenului
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Fereastra ce apare implicit la trecerea în Layout se şterge. 

          

2.  Generarea vederilor 

 
 

Generarea proiecţiilor solidului  se efectuează prin tastarea 

 comenzii SOLVIEW  sau parcurgând traseul:  

Draw  Modeling   Setup  View 

Cu comanda  Solview   se va reprezenta 

vederea frontală. Va fi utilizată opţiunea UCS:  

Command: _solview  

Enter an option [Ucs/ Ortho/ Auxiliary/ Section]: u    

Enter an option [Named/ World/ ? / Current] <Current>:    

Enter view scale <1>:     

Specify view center:   P1   (se indică centrul viewport-ului)   

Specify view center: (se precizează poziţia) sau     

Specify first corner of viewport: P2 (se specifică un colţ al viewport-

ului)  

Specify opposite corner of viewport: P3 (se specifică colţul opus al 

viewport-ului)  

Enter view name: Front  
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Cu comanda  Solview   se va reprezenta vederea de 

sus în legătură proiectivă.Va fi utilizată opţiunea Ortho: 

Enter an option [Ucs/ Ortho/ Auxiliary/ Section]: O  

Specify side of viewport to project: P4 (se indică punctul din care se 

priveşte)  

Specify view center: P5  

Specify view center <specify viewport>:   

Specify first corner of viewport: P6  

Specify opposite corner of viewport:P7  

Enter view name: Top   
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3. Obţinerea secţiunii simple 

Cu comanda Solview  se va reprezentă 

secţiunea de profil în legătură proiectivă. 

Va fi utilizată opţiunea Section:  

În procesul lucrului va fi necesară activarea modului OSNAP 

(opţiunea Cen) .  

Command: _solview 

Enter an option [Ucs/ Ortho/ Auxiliary/ Section]: S    

Specify first point of cutting plane: P8 (se indică un punct din planul 

secant)  

Specify second point of cutting plane: P9 (se indică un punct din 

planul secant)  

Specify side to view from: P10   

Enter view scale <1>:   

Specify view center: P11  

Specify view center <specify viewport>:   

Specify first corner of viewport: P12  

Specify opposite corner of viewport: P13  

Enter view name: Section   
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4.  Realizarea desenului  

În caz de necesitate (dacă a fost modificată scara sau a fost 

pierdută legătura proiectivă) se va utiliza comanda MVSETUP 

 (opţiunile Align şi Scale Viewports)  

Command:  MVSETUP  

Enter an option [Align/Create/Scale viewports/Options/Title block/ 

Undo]: A   

Enter an option [Angled/Horizontal/Vertical alignment/Rotate view/ 

Undo]: H    

Specify basepoint:  

Specify point in viewport to be panned:  

Enter an option [Align/Create/Scale viewports/Options/Title 

block/Undo]: S    

Select the viewports to scale...  

Select objects: 1 found  

Set the ratio of paper space units to model space units...  

Enter the number of paper space units <1.0>: 1    

Enter the number of model space units <1.0>: 1    

Pentru a se modifica stilul de haşură prestabilit, se va realiza 

haşura (model ANSI31)  pe un contur temporar închis (de ex. cerc), 

care îndată va fi şters. 

Transformarea proiecţiilor solidului în vederi 

şi secţiuni cu vedere se efectuează cu comanda 

SOLDRAW:  

Draw  Solids   Setup  Draw 

Command: _soldraw  

Select viewports to draw.. (se aleg pe rând ferestrele, făcându-se 

click pe conturul ferestrei)  

Select objects: 1 found  

Select objects: 1 found, 2 total  

Select objects: 1 found, 3 total  

Select objects: 
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Straturile HID (invizibile) ale tuturor ferestrelor, precum şi 

stratul VPORTS se va îngheaţa.   

Se va crea stratul axe şi se va conferi grosime straturilor VIS 

(contur), HAT (haşură), DIM (cote).  

  

 

Se va copia şi apoi se va alipi chenarul şi indicatorul din alt 

desen.  

Desenul se va cota. Se recomandă să se realizeze cotarea în 

stratul DIM ce corespunde reprezentării respective. 

5.  Salvarea desenului  

  Fişierul se va salva cu numele Nume de familie_7. 

   Exemplu de executare a lucrării grafice vezi în fig. 7. 
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LISTA COMENZILOR UTILIZATE 
 

COMANDA EFECTUL Pagina 

BOX 

CIRCLE 

COPY 

COPYCLIP 

(<Ctrl/C>) 

CUTCLIP 

(<Ctrl/X>) 

CYLINDER 

DDRMODES 

DDEDIT (Modify Text) 

DIMALIGNED 

DIMANGULAR 

DIMBASELINE 

DIMCONTINUE 

DIMDIAMETER 

Dimension (bara) 

Dimension > Oblique 

DIMLINEAR 

DIMRADIUS 

DIMSTYLE 

DTEXT (Single Line Text) 

ELLIPSE 

EXTRUDE 

FILLET 

GRID (<F7>) 

HATCH 

 

ISOPLANE (<F5>) 

 

LAYER 

Layout1 (MODEL) 

LENGTHEN 

LIMITS (Drawing 

Limits) 

LINE 

LINETYPE 

Modelează prismă dreptunghiulară dreaptă 

Desenează cercuri 

Realizează copii ale obiectelor 

Asigură copierea dintr-un document 

(desen) în altul 

Asigură copierea cu tăiere dintr-un 

document (desen) în altul  

Modelează cilindri 

Afişează caseta de dialog  Drafting settings 

Realizează modificarea textului 

Crează o cotă liniară aliniată 

Crează o cotă unghiulară 

Cotează faţă de o bază comună 

Cotează în serie 

Cotează un diametru 

Oferă posibilități de cotare 

Înclină liniile ajutătoare ale cotei 

Crează o cotă liniară 

Cotează o rază de racordare 

Crează şi modifică stilul de cotare 

Afişează textul pe ecran în mod dinamic 

Desenează elipse 

Conferă grosime regiunii 

Realizează racordarea obiectelor 

Afişează o reţea de puncte 

Haşurează o suprafaţă mărginită de un 

contur închis  

Permite comutarea pe planele izometrice 

de lucru 

Crează şi modifică layer-ele 

Comută sistemul în Paper Space 

Modifică lungimea unui segment sau arc 

Stabileşte formatul desenului curent 

 

Desenează segmente de dreaptă 

Controlează tipul liniei 

39 

15,22 

10 

41 

 

34 

 

40 

4 

18 

17 

17 

17 

17 

17 

17 

18,27 

17 

17 

6 

11 

15,25 

33 

21 

4 

26 

 

25 

 

5 

43 

17 

3 

 

10,13 

5 



 
51 

COMANDA EFECTUL Pagina 

LINEWEIGHT 

LTSCALE 

Modeling (bara) 

MVSETUP cu Align 

MVSETUP cu Scale 

Viewports 

OFFSET 

Orbit  (bara) 

 

ORTHO (<F8>) 

OSNAP (<F3>) 

 

PASTECLIP 

(<Ctrl/V>) 

POLAR (<F10>) 

POLYGON 

PROPERTIES 

 

RECTANGLE 

REGION 

REVOLVE 

 

SAVE 

SAVEAS (Save as) 

SNAP (<F9>) 

SOLDRAW 

Solid Editing (bara) 

SOLVIEW 

STYLE (Text Style) 

SUBTRACT 

TRIM 

UCS 

View (Bara) 

Visual Styles (Bara) 

ZOOM 

Controlează afişarea grosimii liniilor 

Stabileşte factorul de scară pentru  liniilor 

Ofera posibilități de modelare a solidelor  

Aliniază proiecțiile 

Modifică scara proiecțiilor 

 

Crează linii echidistante cu cele selectate 

Oferă opțiuni de examinare în spațiu a 

modelului 

Controlează modul ortogonal de desenare 

Permite selectarea precisă a unor puncte 

cu anumite proprietăţi 

Asigură inserarea unui bloc în 

documentul (desenul) curent 

Controlează modul Polar de lucru 

Desenează poligoane regulate 

Afișează a casetă cu proprietățile 

obiectelor selectate 

Desenează un dreptunghi 

Transformă conturul închis în regiune 

Generează solidul prin rotația conturului 

închis 

Salvează desenul 

Salvează desenul curent sub un nume nou 

Controlează pasul cursorului pe ecran 

Transformă proiecțiile în vederi și 

secțiuni 

Oferă posibilități de modificare a solidelor  

Generează proiecții ale solidului 

Crează un stil de scriere 

Elimină unele regiuni din altele 

Retează porţiuni ale obiectelor 

Controlează sistemul de coordonate 

Permite afișarea vederilor standardizate 

Permite alegerea stilului de vizualizare 

Controlează mărimea suprafeţei afişate 

5 

17 

31.33 

47 

47 

 

14 

30,33 

 

11,25 

13,21 

 

34 

 

20 

15 

17 

 

9,16 

32 

37 

 

18 

11 

4,24 

47 

 

31 

44 

6 

32,40 

22 

34,39 

34 

31,33 

4 
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